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Getting Started: Tips to Keep in Mind

Websites

· The Catalog Navigator (CN) website is https://cn.rutgers.edu/.
· The test site for training is https://cndev.rutgers.edu.
· CN does not work with the Safari browser or Explorer version 6 or Google Chrome (Firefox works best).
CN Hierarchy

· Catalog Group

· Catalog

· Chapter

· Subchapter

· Page

· Page Item

Editing
· Edit your section of your catalog only.

· If you are unsure of an edit or have mistakenly deleted something, cancel it. (Use Cancel button or red X in top-left corner.)

· If you have approved a deletion that you shouldn’t have, contact your catalog coordinator or the University Communications and Marketing catalog project manager immediately.

Approving/Rejecting

· Always approve your own work or it will not enter the workflow and will not be seen by those who need to approve it (see Step 8).

· Be sure to submit your changes after you complete all your edits for each page.

· Once you approve your changes and submit them into the workflow, you are not able to go back and make more changes to that section until it is approved at the final stage.

· CN shows rejections for all users in a user group. Look for and make changes to your section only—found in My Approval Inbox (see Step 2).

Formatting/Style

· Please do not alter the style of the catalog even if a pasted Word doc has messed up the formatting. University Communications and Marketing will proofread all changes. Concern yourself only with the content and the accuracy of the data; let University Communications and Marketing worry about the catalog style and look.

Don’t Worry about…

· University Communications and Marketing is responsible for the following catalog sections for all catalogs.  
· About the University (including Governance, Accreditation, and Licensure)
· Academic Policies and Procedures (from the section on Academic Integrity through Patent Policy and all subsections) 
· Divisions of the University
· Many sections that used to be included in the catalogs (e.g., tuition, housing, dining, parking, and other student life and services topics) are now provided in the form of website links featured in a front page to your online catalog after it is completed.
Help
· Contact Karen Imperiale at University Communications and Marketing, kimperiale@ucm.rutgers.edu or 848-445-1937, with problems or questions.
· Check out the Help menu (in the black bar of functions) at cn.rutgers.edu.
Level 1 Editor Instructions: A Step-by-Step Guide

Step 1: 

Login
Step 2: 

Home / My 

Approval Inbox    


Step 3: 

Open

Step 4: 

Navigating Your 

Catalog

Step 4A:

Left-Side Navigation
After you enter the catalog URL in your browser, you will get the Rutgers CAS login page. Enter your Rutgers NetID and password to get into Catalog Navigator.

The first screen you come to after login is the Home page. If you have no items waiting for your approval, proceed to Step 3.

The Home page also features My Approval Inbox where pending approvals are held, awaiting next-level approval. If there are items awaiting your approval, click on the live-linked item in My Approval and be directed to the item awaiting your attention. (Approvals are covered in Step 8.) 

At any point in your approval process you can place your mouse over the File tab at the top left of the page. A drop down box displays Home as the first option. Hover your mouse over the Home option (see it become highlighted) and click, directing you back to the Home / My Approval Inbox page. 

Place your mouse over the File tab at the top left of the page. A drop-down box displays Open as the second option. Hover your mouse over the Open option (see it become highlighted) and click. This displays a list of available catalogs grouped by year, known as Catalog Groups, as well as a group of inactive Archives.
See for yourself: Click on “Rutgers 2016” and you’ll bring up a list of catalogs currently being updated. Find your catalog in the list; click on the title. This brings you to your catalog’s front page.

There are three ways to navigate through your catalog: Left-Side Navigation (Step 4A), Context Panel (Step 4B), and Breadcrumbs (Step 4C).

Beneath your catalog cover picture, find the Left-Side Navigation, which shows the different chapters within your catalog in left-hand column, just like a table of contents. Hover your mouse over the chapter titles; each title is a link to subchapters and pages within your catalog (the CN Hierarchy—see Step 10). 

See for yourself: Click on “Academic Policies and Procedures,” and you’ll make visible the subchapters and pages within that chapter, like “Student Responsibility to Keep Informed.” 

Level 1 Editor Instructions: Continued

Step 4B:

Context Panel

Step 4C:

Breadcrumbs

Step 5:

Edit Buttons

Step 5A:

Edit Buttons in the Context Panel

The Context Panel, located at the top of page beneath the menu bar, is like a compass: it tells you exactly where you are within your catalog. As you navigate through the Left-Side Navigation, the Context Panel changes along with your location within your catalog.

See for yourself: Click on “Academic Policies and Procedures” in the Left-Side Navigation, then click on the subchapter “Student Responsibility to Keep Informed.” See how the Context Panel expands to indicate just where you are in your catalog.
Note about Subchapters: Rutgers’ catalogs utilize many subchapters (smaller chapters within a larger chapter). CN simply refers to these as Chapters in the Context Panel; for the purposes of this guide, we refer to them as Subchapters. 

Just to the right of your catalog cover picture, find your catalog name. As you navigate deeper into the CN Hierarchy (Step 10), each new chapter and subchapter is displayed in order. This is known as Breadcrumbs, which keep track of where you are and where you’ve been with live links; if you wish to take a step back at any point, just click on the name.

See for yourself: Click on “Academic Policies and Procedures” in the Left-Side Navigation, then click on the subchapter “Student Responsibility to Keep Informed.” See how the Breadcrumbs let you know exactly where you are and where you’ve been. Click on your catalog’s name within the Breadcrumbs, and you’re back at the beginning.
Edit Buttons—your tools for making placement and text changes within your catalog—appear in both the Context Panel (Step 5A) and Page Items (Step 5B).

Next to Current Chapter, find Edit Buttons: several arrows, a pencil icon, and an X. Use these tools to make text or placement changes in the navigation of your catalog. 

· The up and down arrows move chapter and/or page titles up and down in the Left-Side Navigation, only. 
· The left arrows insert either a chapter or a page. 

· When activated, the pencil is used to edit a title, NOT TEXT.

· The X is used to delete a chapter or page. Once a page or chapter is deleted, it cannot be recovered. Make sure you are absolutely positive before deleting anything. Contact K. Imperiale before deleting.

Level 1 Editor Instructions: Continued

Step 5A:

Continued

Step 5B:

Edit Buttons in 
Page Items

Step 6:

Adding or Editing Content in the Page Item Edit Window

See for yourself: Hover your mouse over each edit button and an explanation of its function pops up.

At the top of each Page Item in your catalog, find more Edit Buttons. Use these tools to make text or placement changes on the pages within your catalog. These edit buttons are similar buttons to the ones in the context panel, and they basically are used for the same functions. 

· The red up and down arrows move Page Items up and down on the page. The white up-and-down arrow moves items to a specific numbered location on the page and renumbers the other page items accordingly.

· The left arrow inserts new or existing content on a page above the existing text.

· The red “L” opens the Content Item Log and shows all actions taken on the page.

· The pencil is used to insert/edit content. 

· The X is used to delete a Page Item. Once a page or chapter is deleted, it cannot be recovered. Please do not delete any information unless absolutely necessary. Contact K. Imperiale before deleting.
See for yourself: Hover your mouse over each edit button and an explanation of its function pops up.

All catalog content edits are made in the Page Item Edit Window. Click on the pencil at the top of a Page Item to access the edit window, and find features similar to those in Microsoft Word (e.g. spell check, find and replace). Some edit buttons are more commonly used than others in CN.

Edit buttons at the top of the Page Item Edit Window:

· Tables. Create tables with text; there are also icons to insert and delete columns and rows

· Hyperlink. Live link text to another website

· Catalog Link. Live link text to another area in a catalog

· Insert Image. Inserting an image onto the page

· Bold, Italics, and Underline. Format text
Edit buttons at the bottom of the Page Item Edit Window:

· Design and HTML. Changes edit mode; make sure you are always in Design. HTML mode is used for web code/design.

· Check Spelling. Corrects spelling and grammar

· Find/Replace. Helps find a word or phrase quickly and replace it automatically with another word or phrase

· Comment box.  Add a note to the next editor here

Note about Editing Modes: When using the check spelling or find/replace functions, the CN automatically changes to HTML mode. After you have completed the function, saved the changes, and submitted them for approval, the system automatically returns to the Design mode.  Do not be concerned that you will alter any web coding or design.

Level 1 Editor Instructions: Continued

Step 6:

Continued

Step 7:

Creating New Content

When you’ve finished working in the Page Item Edit Window, look at the bottom of the page for a check box with Submit for Editor 1 Approval next to it. In order for an approver to see what changes you have made, this box must be checked before saving. Roll your mouse over the box and click to get a check mark. After this, click Save. Click on Cancel or the red X in the upper left corner of the page if you did not make any changes that you want to keep.  (see also step 8)
Note about Redlining: Notice when a Page Item change is saved and submitted for next-level approval, certain words are crossed through in red (or “redlined”) and others are in green. This feature is used to show you what has changed. A sporadic quirk in the software at times makes it appear that other words or phrases will be deleted that are not supposed to be. It will look strange, but once it is sent through the approval process, the page will revert back to black text, and all your changes will be implemented correctly. 

See for yourself: Click on “Academic Policies and Procedures” in the Left-Side Navigation, then click on the subchapter “Student Responsibility to Keep Informed.” Use the pencil edit button at the top of the Page Item to see the Page Item Edit Window, allowing you to add or edit the content. See the edit buttons; hover your mouse over each edit button and an explanation of its function pops up.

To create new content on a page, click the left arrow next to Current Page in the Context Panel, and see the Insert Content Wizard dialog box open with the question, What do you want to add to the page? and three answer options:

· I want to create new content.

· I want to reuse existing content from any catalog

· I want to link to content in this catalog.

Click the circle to the left of the first option, I want to create new content, and the wizard asks, What type of content do you want to create? and features a drop-down menu with two options: 

· Generic. Regular body text; editor may format. 

· Course. New course text; pre-set fields for easy entry.

Roll your mouse over the two options, choose what you need, then click next.

See for yourself: Click the left arrow next to Current Page in the Context Panel, and see the Insert Content Wizard launch and walk you through inserting new content.

Level 1 Editor Instructions: Continued

Step 7:

Continued

Step 7A:

Creating New Content by Cutting and Pasting from an Existing Word File

Step 8:

Approving or Rejecting Changes or New Content

When creating or editing a course, the edit window layout is different from the generic text edit window. Some of the fields include:

· Course Code. Field in which to enter the course code (example: 10:764:301). 

· Title. Field for the title and number of credits of the course (example: Introduction to Sociology (3)).

· Description. Field used to enter a description of the course.

· Prerequisite. Field for entering the prerequisite(s) of the course; you must type the word “Prerequisite” before the actual information (example: Prerequisite: A contract with a faculty sponsor and permission of the program director).

· Corequisite. Follow the same instructions as for Prerequisite, but use the word “Corequisite” instead of “Prerequisite”  (example: Corequisites: 11:115: 403,404. Recommended: 01:447:380).
· Principal. Field for entering the name of the person who teaches this particular course (example: Smith).
Sometimes the content you need to add or create already exists in a Word document. In that case, copy the text from your Word document, then navigate through your catalog in CN to find the page on which you’d like to paste your copy. Open the Page Item Edit Window using the pencil edit button, place your cursor in the window, and paste the Word file. 

After your paste action is complete, clean up the page by deleting old content and formatting the new. If it is course information, only copy and paste the course Description: be sure to type data such as Course Code, Title, and Prerequisites/Corequisites into the appropriate fields manually.

After you are finished creating new information or editing existing information, look at the bottom of the page for a check box with Submit for Editor 1 Approval next to it. In order for an approver to see what changes you have made, this box must be checked before saving. Roll your mouse over the box and click to get a check mark. After this, click Save. Your changes will be saved and sent in for approval. 

When the edit window closes, see Waiting for Editor 1 Approval at the top of the page. See the check mark and an X on the left side of the box. Click the check mark to send your changes into the workflow for next-level approval—necessary for a full review in CN. 

Level 1 Editor Instructions: Continued

Step 8:

Continued

Step 9:

Other Editing Features

Step 9A:

Adding a Footnote

Step 9B:

Creating a Hyperlink

Step 9C:

Creating a Catalog Link

The X or reject edit button is used mostly by an approver if they want you to correct a change. If an edit you have made is rejected, that page will appear on your Home page the next time you login to CN.  

Note about Approvals: You must approve your work through to the Waiting for Second-level or Approval Approval before it can enter the workflow to be approved by the final approver of your organization. No one will know that work is waiting to be checked and approved if the page is still sitting in the system with the phrase “Edited (Jane Doe 7/20/16)” on top of the Page Item.

Other editing features include Adding a Footnote (9A), Creating Hyperlinks (9B), and Creating Catalog Links (9C).

Adding a Footnote on a page is easy. After launching the edit window using the pencil edit button, see four drop down menus next to the word Body. Click on the menu furthest to the right named Styles; there are several choices. At the bottom of the list is an option named Footer. Type your text at the bottom of the page, highlight it, click the footer option, and you have added a footnote. 
Within your catalogs, you may reference web address (e.g., department page). You can create a live hyperlink from your catalog to the website by highlighting the address within your text and clicking the Create Link edit button (looks like a globe with a chain link across it) to launch the Link Editor window. Just enter the web address, including the http:// (example: http://rutgers.edu), in the top field labeled URL. In the bottom TARGET field, choose NONE. Click OK and you have created a hyperlink.

You also have the ability to link to other pages within a catalog (example: Biological Sciences [See Life Science]). Just highlight the text you wish to link, and click the Create Catalog Link edit button (looks like a page with a chain link across it) to launch the Catalog Link Editor window. Then follow the steps to choose the appropriate area in the catalog (chapter and page) to which you wish to link. If you just want to bring user to main page of a catalog section, select the white space option below select. Click OK and you have created a catalog link.
Level 1 Editor Instructions: Continued

Step 10:

Chapters, Subchapters, 
and Pages

Step 10A:

Creating a Chapter

Step 10B:
Creating a Subchapter

A Chapter (10A) is like a folder that contains other chapters—known as Subchapters (10B)—or Pages (10C). Pages, in turn, are containers for Page Items (the content, your catalog text). Page items cannot be directly attached to chapters; only to pages. 

CN Hierarchy
· Catalog Group

· Catalog

· Chapter

· Subchapter

· Page

· Page Item

K. Imperiale should be contacted before you attempt the following:

In the Context Panel, next to the Current Catalog title, click the Insert Chapter edit button—the right arrow (hover your mouse over the button to confirm its function)—to launch the Insert Chapter window. Type in the title of the chapter you want to create, click Apply, and the new Chapter will appear at the bottom of the Left-Side Navigation after the screen is refreshed (sometimes you need to refresh several times). Click on the name of the new Chapter and see it appear in the Context Panel. Click on the up or down arrows next to the new Chapter’s title in the Context Panel to change the location of the Chapter in your Left-Side Navigation. 

Click on a chapter in the Left-Side Navigation (not the one you just created). In the Context Panel, next to the Current Chapter title, click the Insert Chapter edit button—the second left arrow— (hover your mouse over to confirm its function) to launch the Insert Chapter window. Type in the title of the subchapter you want to create, click Apply, and the new Subchapter will appear below and indented from the Chapter title in the Left-Side Navigation. Click on the name of the new Subchapter and see it appear in the Context Panel. Click on the up or down arrows next to the new Subchapter’s title in the Context Panel to change the location of the Subchapter in your Left-Side Navigation. 

Reminder: CN does not use the term Subchapter in the 
Context Panel!

You also may notice that when you click in the left-side navigation on the Subchapter you just created, it is not associated with a Chapter in the Context Panel and does not appear on the Chapter page. To remedy this you need to create a link between the Subchapter and it corresponding Chapter. 

Level 1 Editor Instructions: Continued

Step 10B:

Continued

Step 10C:

Creating a Page

To create a link between Subchapter and Chapter, click on the Chapter to which you would like to add the Subchapter link in the Left-Side Navigation, then turn your attention to the Context Panel. 

In the Context Panel, next to the Current Page line (which is blank), click the Insert Content edit button—the left arrow (hover your mouse over to confirm its function)—to launch the Insert Content Wizard. 

Click the circle to the left of the third option, I want to link to content in this catalog, and the wizard prompts you to Select the Chapter containing the content item. Do so: highlight the chapter that contains the subchapter you want to link, and click Next. The wizard then ask What do you want to link to? Click the circle to the left of the first option, I want to link to one or more subchapters in this chapter, revealing all the many subchapters and pages available for linking. Click the box next to the Subchapter you want to link. If there is more than one, click all the subchapters you want to link. Then click Finish and the links will appear immediately below the other subchapters associated with the chapter. 

Before creating a Page with content, you need to create a blank page in which to place the content. Click on the chapter or subchapter where you want to insert the content in the Left-Side Navigation. In the Context Panel, next to the Current Chapter title, click the Insert Page edit button—the first left arrow (hover your mouse over to confirm its function)—to launch the Page Details window. Leave the title blank and just click Save. 

Turn your attention back to the Left-Side Navigation, click on the chapter where you want to insert the page, and you see the Context Panel expand to include a blank line next to Current Page. In the Context Panel, next to the Current Page line (which is blank), click the Insert Content edit button—the first left arrow (hover your mouse over to confirm its function)—to launch the Insert Content Wizard. 

Click the circle to the left of the first option, I want to create new content, and the wizard asks, What type of content do you want to create? Choose what you need and click Next. (Refer to Step 7 for more details.)

Level 1 Editor Instructions: Continued

Step 10C:

Continued

Step 11:

Logout

A Page Item Edit Window appears. Type in the title of the Page you want to insert, then type or paste the content you want to use, click Submit for Editor 1 Approval, and click Save. The page will show up immediately at the bottom of the other pages in this chapter or subchapter. Make sure to approve your changes, submitting them for next-level approval (see Step 8).

Click on the page in the Left-Side Navigation, and use the up and down arrows in the Context Panel to change location of the page within your catalog subchapter. This only moves the page name in the left-hand navigation.  Use the move button (double white arrow on top of the item) to move numbered items on the page in front of you.

Note about CN Hierarchy: You only can only move titles in the Left-Side Navigation that are in the same hierarchy. For example, subchapters only can be moved within their chapter.  You cannot move a subchapter up in the hierarchy to match the level of its parent chapter.
When you are done with your work in CN, place your mouse over the File tab at the top left of the page, and click on Logout.

Level 3 or Final Departmental Approver Instructions: A Step-by-Step Guide

Step 1: 

Login
Step 2: 

Home / My 

Approval Inbox    


Step 3: 

Accepting or Rejecting Content

Step 4:

Logout

After you enter the catalog URL in your browser, you will get the Rutgers CAS login page. Enter your Rutgers NetID and password to get into Catalog Navigator.

The first screen you come to after login is the Home page, which features My Approval Inbox where pending approvals are held, awaiting next-level approval. If there are items awaiting your approval, click on the live-linked item in My Approval and be directed to the item awaiting your attention. (Approvals are covered in Step 3.) 

Remember to check your home page daily when a catalog is being actively updated. It is very important to approve or reject any changes made by the Level 1 or Level 2 editors.

At any point in your approval process you can place your mouse over the File tab at the top left of the page. A drop down box displays Home as the first option. Hover your mouse over the Home option (see it become highlighted) and click, directing you back to the Home/My Approval Inbox page. 

A page item whose status is Waiting for Approval is locked until a user authorized to approve or reject content in that catalog takes action. 

Approve. To approve a page item, click the Approve edit button icon—the check mark in the upper left-hand corner of the Page Item. The Page Item will then show the status as Approved. 

Reject. To reject a Page Item, click the Reject edit button—the X in the upper left-hand corner of the Page Item. The Page Item will then show the status as Rejected, and it will be sent back to whoever made the changes in the first place (the Level 1 editor).
When you are done with your work in CN, place your mouse over the File tab at the top left of the page, and click on Logout.

Frequently Asked Questions

How do I approve an edit I have made?

At the top of the page item I just submitted for editor 1 approval, it still says Waiting for Editor 1 Approval.  
What do I do next?

After I finish my edits and send them in for approval, I see a jumble of green and red text with lines through it. Why does it look so strange?

After I edit and approve a page, all of the text is red and crossed out. What is the problem?

I need to make another change, but I already sent it in for approval.  What should I do next? 

How do I create a new course?

After an edit is made, you must check the box next to Submit for Editor 1 Approval and click Save in the Page Item Edit Window to approve your changes. Then, you must click the check mark in the upper-left corner of the Page Item to send your changes into the workflow for Editor 2 or Approver Approval. (See Step 8.)

Click the check mark in the upper-left corner of the Page Item. An Approve Content window will launch; click Approve and the page will move up in the workflow to the level 2 or final approver in your area. (See Step 8.)  Always approve your own work!
Don’t worry—this is not a problem. As a way to track changes, CN displays edits in green and red text (called Redlining). It does look strange, but once it is sent through the approval process, the text will revert back to black type and will contain your edits. (See Step 6.)

This is a sporadic quirk of the CN software.  Rest assured, your text will not be inadvertently deleted—you can double check by clicking on the pencil edit button and viewing your page in the Page Item Edit Window. The text will revert back to black type once it has all been approved. (See Step 6.)

You will need to wait until your edits go through all approvals before any additional changes can be made. (See Step 6.)

When you choose to create new content, the drop down menu offers two different types of content from which you may choose: Generic or Course. Choose Course, and use the template to enter your course information. (See Step 7.)

Frequently Asked Questions: Continued

Why does the text I just copied and pasted look different?

How do I create hyperlinks?

I was editing a large section of my catalog over an extended period of time.  When I went to save all my work, CN asked for my user name and password—I lost all my work. Why?

Why does the top of the page say Edited and not Waiting for Editor 1 Approval?

Sometimes when text is copied and pasted from another source the font may be different from CN’s default font. Don’t fret about this! In order to keep the font uniform in the catalog, University Communications and Marketing will correct any differences during the editing process.

Click on the pencil edit button to launch the Page Item Edit Window, highlight the web address within your text, and click on the Create Link edit button (looks like a globe with a chain link across it) to launch the Link Editor window. Just enter the web address, including the http://, in the top field labeled URL. Choose NONE in the TARGET field. Click OK. (See Step 9B.) 

There is a 20-minute time limit when you’re using a Page Item Edit Window in CN. It is important to save changes every few minutes to avoid the need to duplicate your work!

After completing work in a Page Item Edit Window, you must click the box next to Submit for Editor 1 Approval before clicking Save. If you don’t, the top of the Page Item reads Edited—it has not been entered in the workflow.

If this happens, simply click on the pencil edit button to launch the Page Item Edit Window, click the box next to Submit for Editor 1 Approval, and click Save again.

Don’t forget to approve your work by clicking the check mark in the upper-left corner of the Page Item to promote your edit in the workflow. (See Step 8.) 
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